The smart way to learn Microsoft Project 2013—one step at a time!

Experience learning made easy—and quickly teach yourself how to manage the complete project life cycle with Project 2013. With Step by Step, you set the pace—building and practicing the skills you need, just when you need them!

- Create and fine-tune your project plan
- Schedule tasks, set milestones, and assign resources
- Use Gantt charts to visualize project schedules
- Track progress and troubleshoot variances
- Communicate status with custom reports
- Learn project-management best practices

Your Step by Step digital content includes:

- All the book’s practice files—ready to download at: http://aka.ms/Project2013sbs/files
- Fully searchable ebook. See the instruction page at the back of the book.

Follow the easy numbered steps
Use screenshots to check your work
Get helpful tips and pointers
Build your skills hands-on with ready-made practice files

Build exactly the skills you need. Learn at the pace you want.
Contents

Introduction ................................................................. xi
   Who this book is for .................................................. xi
   How this book is organized ......................................... xi
   Download the practice files ....................................... xii
   Your settings in Project ............................................. xiii
   Your companion ebook ............................................. xiv
   Get support and give feedback ................................... xiv
      Errata ................................................................... xv
      We want to hear from you ....................................... xv
      Stay in touch ....................................................... xv

PART 1

Introduction to Microsoft Project

1 Microsoft Project, project management and you .......... 2
   Meet the Project application ........................................ 3
   Meet the Project family ............................................. 4
   New features in Project 2013 ...................................... 5
      What was new in Project 2010 ............................... 6
      What was new in Project 2007 ............................... 8
   You as a project manager ......................................... 9
      Let’s get started! ................................................... 10
PART 2

Simple Scheduling Basics

3 Starting a new plan
Starting a new plan, and setting its start date ........................................... 42
Setting nonworking days in the project calendar ......................................... 45
Entering the plan’s title and other properties ............................................... 48
Key points ..................................................................................................... 50

4 Building a task list
Entering task names ..................................................................................... 54
Entering task durations .................................................................................. 57
Entering a milestone task .............................................................................. 62
Creating summary tasks to outline the plan ............................................... 63
Creating task dependencies with links ....................................................... 66
Switching task scheduling from manual to automatic .................................. 72
Checking the plan’s duration and finish date .............................................. 76
Documenting tasks with notes and hyperlinks .......................................... 78
Key points ..................................................................................................... 81
### 5 Setting up resources

- Entering work resource names ......................................... 84
- Entering resources’ maximum capacity ................................ 87
- Entering resource pay rates ............................................. 89
- Adjusting working time in a resource calendar ...................... 92
- Setting up cost resources ............................................... 97
- Documenting resources with notes .................................... 98
- Key points ........................................................................... 101

### 6 Assigning resources to tasks

- Assigning work resources to tasks .................................... 104
- Controlling work when adding or removing resource assignments ......................................................... 112
- Assigning cost resources to tasks .................................... 116
- Checking the plan’s duration, cost, and work ....................... 118
- Key points ........................................................................... 122

### 7 Formatting and sharing your plan

- Customizing a Gantt Chart view ........................................ 126
- Customizing a Timeline view ............................................. 133
- Customizing reports ....................................................... 136
- Copying views and reports ............................................... 139
- Printing views and reports .............................................. 144
- Key points ........................................................................... 149

### 8 Tracking progress

- Saving a baseline of your plan .......................................... 153
- Tracking a plan as scheduled through a specific date ............ 156
- Entering a task’s completion percentage ............................. 157
- Entering actual values for tasks ....................................... 160
- Key points ........................................................................... 165
## PART 3

### Advanced Scheduling Techniques

<table>
<thead>
<tr>
<th>9</th>
<th>Advanced task scheduling</th>
<th>170</th>
</tr>
</thead>
<tbody>
<tr>
<td>See task relationships with Task Path</td>
<td>170</td>
<td></td>
</tr>
<tr>
<td>Adjusting task link relationships</td>
<td>173</td>
<td></td>
</tr>
<tr>
<td>Setting task constraints</td>
<td>179</td>
<td></td>
</tr>
<tr>
<td>Interrupting work on a task</td>
<td>185</td>
<td></td>
</tr>
<tr>
<td>Adjusting working time for individual tasks</td>
<td>187</td>
<td></td>
</tr>
<tr>
<td>Control task scheduling with task types</td>
<td>191</td>
<td></td>
</tr>
<tr>
<td>Key points</td>
<td>197</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>10</th>
<th>Fine-tuning task details</th>
<th>198</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entering deadline dates</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>Entering fixed costs</td>
<td>202</td>
<td></td>
</tr>
<tr>
<td>Setting up a recurring task</td>
<td>204</td>
<td></td>
</tr>
<tr>
<td>Viewing the project’s critical path</td>
<td>208</td>
<td></td>
</tr>
<tr>
<td>Scheduling summary tasks manually</td>
<td>211</td>
<td></td>
</tr>
<tr>
<td>Key points</td>
<td>215</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>11</th>
<th>Fine-tuning resource and assignment details</th>
<th>216</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting up resource availability to apply at different times</td>
<td>218</td>
<td></td>
</tr>
<tr>
<td>Entering multiple pay rates for a resource</td>
<td>221</td>
<td></td>
</tr>
<tr>
<td>Setting up resource pay rates to apply at different times</td>
<td>223</td>
<td></td>
</tr>
<tr>
<td>Setting up material resources</td>
<td>225</td>
<td></td>
</tr>
<tr>
<td>Delaying the start of assignments</td>
<td>226</td>
<td></td>
</tr>
<tr>
<td>Applying contours to assignments</td>
<td>229</td>
<td></td>
</tr>
<tr>
<td>Applying different pay rates to assignments</td>
<td>234</td>
<td></td>
</tr>
<tr>
<td>Assigning material resources to tasks</td>
<td>236</td>
<td></td>
</tr>
<tr>
<td>Viewing resource capacity</td>
<td>238</td>
<td></td>
</tr>
</tbody>
</table>
Adjusting assignments in the Team Planner view ............................................. 241
Key points ........................................................................................................ 247

12 Fine-tuning the Project plan ......................................................................... 248
Examining resource allocations over time ......................................................... 250
Resolving resource overallocations manually ................................................. 255
Leveling overallocated resources ..................................................................... 259
Checking the plan’s cost and finish date ........................................................... 267
Inactivating tasks ............................................................................................... 271
Key points ........................................................................................................ 273

13 Organizing project details ............................................................................. 274
Sorting Project details ....................................................................................... 276
Grouping Project details .................................................................................. 280
Filtering Project details ................................................................................... 285
Creating new tables .......................................................................................... 290
Creating new views .......................................................................................... 294
Key points ........................................................................................................ 297

14 Tracking progress on tasks and assignments .............................................. 298
Updating a baseline .......................................................................................... 300
Tracking actual and remaining values for tasks and assignments ................... 305
Tracking timephased actual work for tasks and assignments ......................... 312
Rescheduling incomplete work .......................................................................... 317
Key points ........................................................................................................ 320

15 Viewing and reporting project status .......................................................... 322
Identifying tasks that have slipped .................................................................. 324
Examining task costs ......................................................................................... 330
Examining resource costs ............................................................................... 333
Reporting project cost variance with a stoplight view ...................................... 336
Key points ........................................................................................................ 341
PART 4

In-Depth and Special Subjects

17 Applying advanced formatting and printing 362
  Formatting a Gantt chart view .................................................. 364
  Formatting a Timeline view ....................................................... 371
  Formatting a Network Diagram view ......................................... 373
  Formatting a Calendar view ...................................................... 378
  Printing and exporting views .................................................... 381
  Key points ............................................................................. 387

18 Advanced report formatting 388
  Formatting tables in a report ..................................................... 390
  Formatting charts in a report ..................................................... 399
  Creating a custom report .......................................................... 406
  Key points ............................................................................. 415

19 Customizing Project 416
  Sharing custom elements between plans .................................. 418
  Recording macros .................................................................. 423
  Editing macros ...................................................................... 429
  Customizing the ribbon and Quick Access Toolbar .................. 434
  Key points ............................................................................. 440
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>B  Developing your project-management skills</strong></td>
<td>513</td>
</tr>
<tr>
<td>Joining a Project learning community</td>
<td>514</td>
</tr>
<tr>
<td>Joining a project-management learning community</td>
<td>515</td>
</tr>
<tr>
<td>Final words</td>
<td>516</td>
</tr>
<tr>
<td><strong>C  Collaborating: Project, SharePoint, and PWA</strong></td>
<td>517</td>
</tr>
<tr>
<td>Introduction to sharing your plan with SharePoint</td>
<td>517</td>
</tr>
<tr>
<td>Introduction to team collaboration with Project Web App</td>
<td>521</td>
</tr>
<tr>
<td>Introduction to Enterprise Project Management</td>
<td>526</td>
</tr>
<tr>
<td><strong>D  Using this book in a classroom</strong></td>
<td>529</td>
</tr>
<tr>
<td>Matching content to instructional needs</td>
<td>529</td>
</tr>
<tr>
<td>Teaching project management with Project</td>
<td>531</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td>533</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>543</td>
</tr>
<tr>
<td><strong>About the authors</strong></td>
<td>558</td>
</tr>
<tr>
<td><strong>How to download your ebook</strong></td>
<td>559</td>
</tr>
<tr>
<td><strong>Survey page</strong></td>
<td>560</td>
</tr>
</tbody>
</table>
Introduction

Microsoft Project 2013 is a powerful tool for creating and managing projects. *Microsoft Project 2013 Step by Step* offers a comprehensive look at the features of Project that most people will use most frequently.

Who this book is for

*Microsoft Project 2013 Step by Step* and other books in the Step by Step series are designed for beginning to intermediate-level computer users. Examples shown in the book generally pertain to small and medium organizations but teach skills that can be used in organizations of any size. Whether you are already comfortable working in Project and want to learn about new features in Project 2013 or are new to Project, this book provides invaluable hands-on experience so that you can plan, track, and manage projects.

How this book is organized

This book is divided into four parts:

- Part 1 introduces you to the rich field of project management and shows you the major parts of the Project 2013 interface.
- Part 2 takes you through a complete project life cycle (planning, tracking, and managing) with a streamlined use of Project features and capabilities.
- In Part 3, you complete another project life cycle, this time with more in-depth use of the powerful capabilities of Project.
- Part 4 wraps up your training with Project with activities that can be applied at any point in a project life cycle.

In addition, this book includes several appendices. The appendices give you broader exposure to the field of project management, collaboration features in Project that are enhanced with SharePoint and Project Web App, and some suggestions for using this book in a classroom setting.
This book’s iterative focus on completing a full project life cycle takes you through planning and then into the areas of tracking progress and responding to variance, where Project’s feature set really shines.

This book has been designed to lead you step by step through all the tasks you’re most likely to want to perform with Project 2013. If you start at the beginning and work your way through all the exercises, you will gain enough proficiency to manage complex projects. However, each topic is self-contained, so you can jump in anywhere to acquire exactly the skills you need.

Download the practice files

Before you can complete the exercises in this book, you need to download the book’s practice files to your computer. These practice files can be downloaded from the following page:

http://aka.ms/Project2013sbs/files

The same set of practice files works with both Microsoft Project Professional 2013 and Microsoft Project Standard 2013. Differences between the two editions of Project are explained where needed throughout the book.

IMPORTANT The Project 2013 program is not available from this website. You should purchase and install that program before using this book.

The following table lists the practice files for this book.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1: Microsoft Project, project management and you</td>
<td>No practice file</td>
</tr>
<tr>
<td>Chapter 2: A guided tour of Project</td>
<td>Guided Tour_Start.mpp</td>
</tr>
<tr>
<td>Chapter 3: Starting a new plan</td>
<td>No practice file</td>
</tr>
<tr>
<td>Chapter 4: Building a task list</td>
<td>Simple Tasks_Start.mpp</td>
</tr>
<tr>
<td>Chapter 5: Setting up resources</td>
<td>Simple Resources_Start.mpp</td>
</tr>
<tr>
<td>Chapter 6: Assigning resources to tasks</td>
<td>Simple Assignments_Start.mpp</td>
</tr>
<tr>
<td>Chapter 7: Formatting and sharing your plan</td>
<td>Simple Formatting_Start.mpp</td>
</tr>
<tr>
<td>Chapter 8: Tracking progress</td>
<td>Simple Tracking_Start.mpp</td>
</tr>
</tbody>
</table>
Your settings in Project

There are many settings that can affect the results you see as you complete the exercises in this book—especially settings relating to how Project calculates schedules. When working with Project, there are two levels of detail at which such settings apply:

- **Settings unique to the Project file**
- **Settings that apply to all Project files you work with in Project**

We’ve already made all the necessary settings possible in the practice files you’ll use with this book. However, your installation of Project might have settings that differ from the “factory default” settings, and it could produce results that differ from what’s shown in this book. If you don’t get the results you expect, check these settings.
<table>
<thead>
<tr>
<th>This setting</th>
<th>Should be</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Options &gt; General tab &gt; Default View</td>
<td>Gantt with Timeline</td>
</tr>
<tr>
<td>File &gt; Options &gt; Display tab &gt; Show Indicators and Options Buttons For</td>
<td>All options here should be selected</td>
</tr>
<tr>
<td>File &gt; Options &gt; Schedule tab &gt; Show Assignment Units As A</td>
<td>Percentage</td>
</tr>
<tr>
<td>File &gt; Options &gt; Schedule tab &gt; Calculation &gt; Calculate Project After Each Edit</td>
<td>On</td>
</tr>
<tr>
<td>File &gt; Options &gt; Save tab &gt; Save Files In This Format</td>
<td>Project (*.mpp)</td>
</tr>
<tr>
<td>File &gt; Options &gt; Advanced tab &gt; Edit</td>
<td>All options here should be selected</td>
</tr>
<tr>
<td>File &gt; Options &gt; Advanced tab &gt; Display &gt; Show Status Bar</td>
<td>Selected</td>
</tr>
<tr>
<td>File &gt; Options &gt; Advanced tab &gt; Display &gt; Show Scroll Bars</td>
<td>Selected</td>
</tr>
<tr>
<td>Resources &gt; Level &gt; Leveling Options &gt; Leveling Calculations</td>
<td>Manual</td>
</tr>
<tr>
<td>Resources &gt; Level &gt; Leveling Options &gt; Look for Overallocations On A</td>
<td>Day By Day</td>
</tr>
</tbody>
</table>

Your companion ebook

With the ebook edition of this book, you can do the following:

- Search the full text
- Print
- Copy and paste

To download your ebook, see the instruction page at the back of the book.

Get support and give feedback

The following sections provide information about getting help with this book and contacting us to provide feedback or report errors.
Errata

We’ve made every effort to ensure the accuracy of this book and its companion content. Any errors that have been reported since this book was published are listed on our Microsoft Press site, which you can find at:

http://aka.ms/Project2013sbs/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, email Microsoft Press Book Support at mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the addresses above.

We want to hear from you

At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance for your input!

Stay in touch

Let’s keep the conversation going! We’re on Twitter at: http://twitter.com/MicrosoftPress.
Chapter at a glance

Create
Create a new plan, page 42.

Start
Set the new plan’s start date, page 43.

Holiday
Set working-time exceptions in the project calendar, page 45.

Detail
Enter properties like the plan’s title, page 48.
IN THIS CHAPTER, YOU WILL LEARN HOW TO

- Start a new plan, set its start date, and save it.
- Review the available base calendars, and then create a working-time exception in the project calendar.
- Enter some properties about the plan.

A project’s schedule or plan is essentially a model that you construct of some aspects of a project you are anticipating—what you think will happen, or what you want to happen. This model focuses on some, but not all, aspects of a project—tasks, resources, time frames, and possibly their associated costs. Note that throughout this book, we’ll refer to the types of documents that Microsoft Project 2013 works with as plans, not documents or schedules.

PRACTICE FILES  Before you can complete the exercises in this chapter, you need to copy the book’s practice files to your computer. A complete list of practice files is provided in “Download the practice files” at the beginning of this book. For each exercise that has a practice file, simply browse to where you saved the book’s practice file folder.

IMPORTANT  If you are running Project Professional with Project Web App/Project Server, take care not to save any of the practice files you work with in this book to Project Web App (PWA). For more information, see Appendix C, “Collaborating: Project, SharePoint, and PWA.”
Starting a new plan, and setting its start date

As you might expect, Project focuses primarily on time. Sometimes you might know the planned start date of a project, the planned finish date, or both. However, when working with Project, you specify only one date, not both: the project start date or the project finish date. Why? Because after you enter the project start or finish date and other project details, Project calculates the other date for you. Remember that Project is not just merely a static repository of your schedule information or a Gantt chart drawing tool—it is an active scheduling engine.

Most plans should be scheduled from a start date, even if you know that the project should finish by a certain deadline date. Scheduling from a start date causes all tasks to start as soon as possible, and it gives you the greatest scheduling flexibility. In this and later chapters, you will see this flexibility in action as you work with a project that is scheduled from a start date.

Now that you’ve had a brief look at the major parts of the Project interface in Part 1, “Introduction to Microsoft Project,” you are ready to create the plan you will use throughout Part 2 of this book, “Simple scheduling basics.”

The scenario: Throughout this book, you’ll play the role of a project manager at Lucerne Publishing, a book publisher that specializes in children’s books. Lucerne is about to publish a major new book, and you’ve been asked to develop a plan for the book launch.

In this exercise, you create a new plan, set its start date, and save it.

**SET UP**  You don’t need practice files to complete this exercise; just follow the steps.

1. Do one of the following:
   - In Project, if you see the **File** tab, click it, and then click **New**.
   - If you already see a list of available templates in the Start screen, continue to the next step.

Project displays your options for creating a new plan. These options include using templates installed with Project or that are available on the web. You see this same list of templates in the Start screen when you start Project, and in the New screen on the File tab.
For this exercise, you will create a new blank plan.

2 In the list of available templates, click Blank Project.

Project creates a new plan. You might see a status bar message at the bottom of the window reminding you that new tasks are created in the manually scheduled mode. This information remains visible on the status bar.

Notice the thin green vertical line in the chart portion of the Gantt Chart view. This indicates the current date. When you create a new plan, Project sets the plan’s start date to the current date. Next you’ll change the plan’s start date.

3 On the Project tab, in the Properties group, click Project Information.

The Project Information dialog box appears.

**IMPORTANT** If you are using Project Professional rather than Project Standard, the Project Information dialog box and some other dialog boxes contain additional options relating to Project Server. Throughout this book, we won’t use Project Server, so you can ignore these options. For more information about Project Server, see Appendix C, “Collaborating: Project, SharePoint, and PWA.”

4 In the Start Date box, type 1/5/15, or click the down arrow to display the calendar and select January 5, 2015.
**TIP** In the calendar, you can use the left and right arrows to navigate to any month and then click the date you want, or click Today to quickly choose the current date.

Note in the Schedule From drop-down list the *Project Start Date* value. As noted previously, because this plan is scheduled from the start date, you enter the start date and Project calculates the finish date based on the schedule details contained in the plan.

5. Click **OK** to accept this start date and close the Project Information dialog box. Project scrolls the chart portion of the Gantt Chart view to show the project start date. The start date is shown as a thin dashed vertical line.

**TIP** You can set Project to automatically display the Project Information dialog box each time you create a new plan. To make this change, on the File tab click Options. In the Project Options dialog box, click the Advanced tab, and then under General, select Prompt For Project Info For New Projects.

6. On the **File** tab, click **Save**.
   Because this plan has not been previously saved, the Save As screen appears.

7. Under **Save and Sync**, click **Computer**, and then click **Browse**.

8. Locate the Chapter03 folder in the Project 2013 Step by Step folder on your hard disk.

9. In the **File name** box, type **Simple Plan**.

10. Click **Save** to save the plan and close the Save As dialog box.
**TIP** You can instruct Project to automatically save the active plan at predefined intervals, such as every 10 minutes. On the File tab, click Options. In the Project Options dialog box, click Save, select the Auto Save Every check box, and then specify the time interval you want.

### Setting nonworking days in the project calendar

Calendars are the primary means by which you control when each task and resource can be scheduled for work in Project. In later chapters, you will work with other types of calendars; in this chapter, you work only with the project calendar.

The *project calendar* defines the general working and nonworking days and time for tasks. Project includes multiple calendars, called *base calendars*, any one of which can serve as the project calendar for a plan. You select the base calendar that will be used as the project calendar in the Project Information dialog box. Think of the project calendar as your organization’s normal working hours. For example, this might be Monday through Fridays, 8 A.M. through 5 P.M., with a one-hour lunch break each day. Your organization or specific resources might have exceptions to this normal working time, such as holidays or vacation days. You’ll address resource vacations in Chapter 5, “Setting up resources.”

You manage calendars through the Change Working Time dialog box (accessed on the Project tab). Use this dialog box to set normal working schedules and working-time exceptions for individual resources or, as you’ll do here, the entire plan.

The scenario: At Lucerne Publishing, you need to account for an upcoming date on which the entire Lucerne staff will be unavailable to work on the book launch project.

In this exercise, you’ll review the available base calendars and then create a working-time exception in the project calendar:

1. **On the Project tab, in the Properties group, click Project Information.**
   The Project Information dialog box appears.
2. **In the Calendar box, click the down arrow.**
The list that appears contains the three base calendars included with Project:

- **24 Hours**  
  Has no nonworking time

- **Night Shift**  
  Covers a “graveyard” shift schedule of Monday night through Saturday morning, 11 P.M. to 8 A.M., with a one-hour break each day

- **Standard**  
  The traditional working day and week, Monday through Friday from 8 A.M. to 5 P.M., with a one-hour break each day

Only one of the base calendars serves as the project calendar. For this project, you’ll use the Standard base calendar as the project calendar, so leave it selected.

3. Click **Cancel** to close the Project Information dialog box without making any changes.

You know the entire Lucerne staff will be at a morale event on January 22; therefore, no work should be scheduled that day. You will record this as a calendar exception.

4. On the **Project** tab, in the **Properties** group, click **Change Working Time**.
   
The Change Working Time dialog box appears.

5. In the **Name** field on the **Exceptions** tab in the lower portion of the dialog box, type **Staff at morale event**, and then click in the **Start** field.
   
   **TIP** You don’t need to name calendar exceptions, but it’s a good practice for you or others to identify the reason for the exception.

6. In the **Start** field, type **1/22/15**, and then click the **Finish** field or press the Right Arrow key.
   
   **TIP** You can also select the date you want in the calendar above the Exceptions tab or from the drop-down calendar in the Start field.
Here you can see that the Standard base calendar is designated as the Project Calendar.

The date is now scheduled as nonworking time for the project. In the dialog box, the date appears underlined and color formatting is applied to indicate an exception day.

7 Click OK to close the Change Working Time dialog box.

To verify the change to the project calendar, note in the chart portion of the Gantt Chart view that Thursday, January 22, is now formatted as gray to indicate nonworking time (just like the weekends).

In this section, you made just one specific day a nonworking day for the entire plan. Other common examples of working time adjustments include:

- Recurring holidays or other times off that follow a known pattern, such as weekly, monthly, or annually. To set up recurring nonworking times, click the Details button on the Exceptions tab in the Change Working Time dialog box.

- Vary working times per week, for example, to address seasonal changes in working times. To set up custom work weeks, on the Work Weeks tab of the Change Working Time dialog box, enter the date range you want, click the Details button, and then set the working time adjustments you want.

- Unique working hours for a resource. You’ll make such settings in Chapter 5.
Entering the plan’s title and other properties

Like other Microsoft Office applications, Project keeps track of several file properties. Some of these properties are statistics, such as how many times the file has been revised. Other properties include information that you might want to record about a plan, such as the project title, the project manager’s name, or keywords to support a file search. Some of these properties are used in views, in reports and in page headers and footers when printing. You can see and record these properties in the Advanced Properties dialog box.

The scenario: At Lucerne Publishing, you want to record top-level information about the new book launch plan. These details won’t affect the overall schedule but relate to important supplemental information you want to keep in the plan.

In this exercise, you enter some properties about the plan that you will use later when printing and for other purposes:

1. Click the File tab.
   The Backstage view appears. The Info tab should be selected by default. On the right side of the screen, under Product Information, note the key statistics, such as the start date on the right side of the Backstage view. Notice that many of the fields you see here are the same fields you see in the Project Information dialog box. You can edit these fields in either place.

2. Click Project Information. In the menu that appears, click Advanced Properties.
   The Properties dialog box appears with the Summary tab visible.

3. In the Subject box, type New book launch schedule.

4. In the Manager box, type Carole Poland.

5. In the Company box, type Lucerne Publishing.

7. Click **OK** to close the dialog box.
   
   To conclude this exercise, you will save the Simple Tasks file, and then close it.

8. On the **File** tab click **Save**.

---

**Project management focus: Project is part of a larger picture**

Depending on your needs and the information to which you have access, the plans that you develop might not deal with other important aspects of your projects. For example, many large projects are undertaken in organizations that have a formal change-management process. Before a major change to the scope of a project is allowed, it must be evaluated and approved by the people managing and implementing the project. Even though this is an important project-management activity, it is not something done directly within Project.

---

**CLEAN UP** Close the Simple Plan file.
Key points

▪ Scheduling a plan from a start date (as opposed to a finish date) gives you the most flexibility.

▪ You use calendars in Project to control when work can be scheduled to occur.

▪ You should record file properties in a plan for later use when printing views and reports.
8/80 rule, 62
% Complete field, 165, 396–397
% Work Complete field, 165, 396–397

A
accrual methods, 203–204
Actions list, 112–115, 194–195
Active Directory, importing resource details to, 6
actual costs, 267, 311. See also costs
actual work, 299, 308–309, 314. See also work actuals, 152, 316, 319
  entering, 161–165, 308–309
  recording, 157–158
  tracking, 299, 305–310
Add Tasks To Timeline dialog box, 134–135
Add to Timeline command (Task tab), 136
Advanced Properties dialog box, 48
All Subtasks view, 214
allocation, 250–255. See also overallocation
apps for Office, 6
As Soon As Possible constraints, 200–201
Assign Resources command (Resources tab), 23
Assign Resources dialog box, 23, 105–110
  Cost field, 117–118
  cost values, entering, 98
  material resources, assigning, 236–237
  Replace button, 255
  Resource list, 118
  Units field, 255
Assignment Information dialog box, 227–231, 235
assignment notes, 79, 233
assignments, 103, 103–116, 120–121
  actual work values, 308–310
  adding and removing, 112–116
  contouring, 187, 229–234
  of cost resources, 116–118
  costs, 90, 106, 118
  delaying, 226–229, 261
  editing, 229
  overtime, adding, 352
  peak units, 191
  reassigning, 245–246
  recurring tasks, 206–208
  Resource Names column, 109–110
  in sharer plans, 476–478, 489–493
  in Team Planner view, 241–246
  units value, 104, 192–193
  variance, viewing, 330
  viewing across plans, 474–476
  work values, manually editing, 232–233
Auto Schedule command (Task tab), 74–75
AutoFilter, 7, 278, 285–287
availability of resources, 218–221, 254

B
Backstage view, 7, 17–21
  SkyDrive access, 5
Bar command (Format tab), 131–132
Bar Styles command (Format tab), 132
Bar Styles dialog box, 26–27, 365–370
  Gantt charts, formatting, 128
base calendars, 45–46, 98, 188–190, 482–484
Baseline command, 370
baseline costs, 267
baseline plans, 152, 156
  multiple, 154–155, 301
  saving, 154–156, 302–304
  updating, 300–304
Blank Project template, 43
book, training and instruction with, 529–532
Box command (Format tab), 378
Box Styles command (Format tab), 378
Box Styles dialog box, 375
Budget Cost Report, 333
burdened rates, 93

C
Calendar view, 25, 378–381
  calendars, 44
  base calendars, 45–46, 98, 188–190, 482–484
  custom, 418, 420–423
  exceptions, 46–47, 479–480
  project calendars, 45
  resource calendars, 93–98
callouts, displaying tasks as, 136
change highlighting, 8, 69, 184, 308
Change Working Time dialog box, 45–47, 479, 481–483
  base calendar, changing, 98
  base calendars, creating, 188
  Work Weeks tab, 189
  working-time exceptions, adding, 94–95
  working week days and times, modifying, 96–97
Chart Styles group, 139
charts
  contextual commands, 400
  data labels, 411–412
  Design tab, 399
  elements, adding, 402–403
  fields, adding and removing, 409–410
  filtering data, 400, 402
  Format tab, 400
  formatting, 138–139, 399–406
  legend, hiding, 412
  reports, adding to, 408–413
  Time category value, 404
  timescale, adjusting, 404
Chatfield, Carl, 514
Clear All Filters command (View tab), 287
Clear command (Task tab), 81
Clear Filter command (View tab), 290
Clear Group command (View tab), 284
collaboration features, 517–528
Collapse Boxes command, 378
color styles, 25–26
commands, 16, 22–27. See also individual command names
  adding to Quick Access Toolbar, 434–436
  keyboard shortcuts, 27
  split buttons, 24
completion percentages, 158–161, 165
cost variance, 330–333
  resource costs, 334, 354–355
  usage view, 333
costs
  actual, 267
  assignment details, relationship with, 353
  baseline, 267
  calculation, 104
  as constraint, 508
  cost per use (set fee), 91, 225
  current (scheduled), 267
displaying, 254
  entering, 202–204
  legends, adding to, 384
  planned, 117
  rates, 90–93
  remaining, 267
  resource costs, 85, 333–336
timephased values, 336
  viewing, 118–122, 267–270
  managing, 509–512
  Must Finish On, 200
  scope, 508–510
  As Soon As Possible, 200
  Start No Earlier Than, 205
time, 507
  contours, 229–234
    back-loaded, 230–231
details, recording in notes, 233
  fixed-duration tasks and, 232
  flat (default), 230
  indicators, 231–232
  Copy Picture dialog box, 141, 426
  Copy Report command (Design tab), 144
  Copy Timeline command (Format tab), 142–143
cost rate tables, 222–224
  changing, 234–235
  multiple pay rates, 223
cost resources, 8, 84, 203
  assigning, 116–118
  costs, 117
  setting up, 98–99
cost table, 120, 162, 234–235, 267–269
cost variance, 330–332
  resource costs, 334, 354–355
  usage view, 333
cost variance, 330–333
costs
  assigning, 116–118
  current (scheduled), 267
cost variance, 330–333
graphical indicators, 339–340
  stoplight view, 336–341
troubleshooting, 352–355
  actual, 267
  assignment details, relationship with, 353
  baseline, 267
  calculation, 104
  as constraint, 508
  cost per use (set fee), 91, 225
  current (scheduled), 267
displaying, 254
  entering, 202–204
Create New Base Calendar dialog box, 188–189

critical path
  crashing, 208
  finish dates and, 268
  formatting, 210
  recalculation of, 210
  slack and, 208–201
  viewing, 208–210, 346–347

critical tasks, 268, 380
cross-plan links, 497–502
current (scheduled) costs, 267
Custom AutoFilter dialog box, 286
custom elements, sharing between plans, 418–423
Custom Fields dialog box, 337–338

D
data maps, 450, 452–453, 456
Data Template Definition dialog box, 376
Data Templates dialog box, 375–376
data types, 7
dates. See also finish dates; start dates
deadlines, 184, 200–202, 507
  linking objects to, 134
deadlines, 184, 200–202, 507
Define Group Interval dialog box, 283
Define New View dialog box, 294
Delete Task command, 57
deliverables, 57, 506
dependencies, 54
  creating, 67–73
  between plans, creating, 496–502
  reasons for, 496–497
  scheduling and, 75
Design tab, 22, 35
destination programs, 441
Detail Gantt view, 209, 210, 325
Details dialog box, 95
dialog box launcher buttons, 26–27
Display AutoFilter command (View tab), 278
Document Export Options dialog box, 386–387
Drawing tool, 133–134
driving constraints, 344
driving predecessors, 170–172
Driving Predecessors command (Format tab), 171–172
duration, 54, 77–79, 505
  abbreviations for, 58
  actuals, recording, 163–165
  adjusting, 112–115, 194–195, 350
  contours and, 232
critical path, managing with, 210
  elapsed, 59–60
  elapsed time vs. work accomplished, 165
  entering, 58–63, 72
  estimating, 62–63
  manually setting, 211–214
  numerical values, 75
  of recurring tasks, 207
  reducing, 352
  Scheduled Duration value, 214
  split tasks, 187
  standard values, 59
  of summary tasks, 64, 211–214
  text values, 58–59, 62
  viewing, 118–122

effect-driven scheduling, 116, 191, 196
effect-driven tasks, 112–116
email
copying Project data to, 442
plans, sending, 19
Enterprise Project Management (EPM), 526–528
Entire Project view, 212
Entry table, 156, 175
equipment resources, 86. See also work resources
Excel
  importing data from, 449–452
  pasting Project data into, 445–447
  PivotTables, 458, 460
  saving projects as workbooks, 452
  visual reports, 8, 458–461
exceptions, working-time, 8, 45–47, 94–95, 479–480
Export Wizard, 455–457
exporting data, 19, 382, 385–387, 455–459
external tasks, 498–499, 501

F
Field List pane, 139, 390–391
  displaying, 392–393
  field hierarchy, 393
resource names, reordering, 403–405
selected field names, 393
fields
% Complete field, 165, 396–397
% Work Complete field, 165, 396–397
custom, 7, 293
sorting by, 279
file formats of Project, 459
Filter Definition dialog box, 288, 329
filtering
  AutoFilters, 7, 278, 285–287
cost variance, 332–333
custom filters, 287–289
incomplete tasks, 358
predefined filters, 285
project details, 7, 284–290
removing, 290
by resource, 355
resources by cost, 334–335
slipping and late tasks, 325, 327–328
finish dates, 42, 77–79
  critical path and, 208, 268
  entering, 61
  Finish No Earlier Than constraint, 184
interim plan, 304
latest, 6
of recurring tasks, 205, 207
resource leveling and, 261
Scheduled Finish dates, 214
viewing, 119, 267–270
finish-to-finish (FF) task relationships, 67, 174
finish-to-start (FS) task relationships, 67, 173–175
fixed costs, 202–204
fixed-duration task type, 191
fixed-unit task type, 191
fixed-work task type, 191
flexible constraints, 179–180, 182
float, 208
forecasts, 324
Form views, 145
Format Bar dialog box, 131–132
Format Data Label pane, 411
Format tab, 22
  Bar Styles group, 128, 131
  Baseline and Slippage commands, 370
  contextual nature, 371–372
  Current Selection group, 136
  Details group, 100
  Drawings group, 134
  Format group, 133
  Gantt Chart Style group, 128–130
  Insert group, 134
  label, 29
  Layout button, 370
  Show/Hide group, 79
  Text Styles button, 370
formatting, 7
  Calendar view, 378–381
  charts, 399–406
critical path and slack, 210
direct, 372–373
Gantt chart views, 127–134, 302, 364–370
link lines, 370
Network Diagram view, 373–378
overallocation, 253–254
style-based, 371–372
summary data rows, 281
tables, 390–399
text, 370–373
timeline view, 371–373
Formula dialog box, 338
formulas, custom, 338
free slack, 208–210
G
Gantt, Henry, 127
Gantt bars
color formatting, 170–173
details, viewing, 370
linking objects to, 133–134
names, 366
progress bars, 158, 160
From and To values, 367–368
Gantt Chart button, 271
Gantt Chart Style group, 128–130
Gantt Chart view, 22, 24–27
  actuals, displaying, 163
bar chart, 127
baseline and slippage bars, 330
baseline values, 156
copying, 140–142
customizing, 127–134
Gantt bars, 128, 327
horizontal gridlines, 132–133
panning and zooming, 137
Print Preview, 146–148
printing options, 382–385
project summary task, 79, 119
Resource Names column, 109–110
timescale, 28
Gantt chart views, 127, 364
displaying, 271
drawing on, 133–134
formatting, 127–134, 302, 364–370
gridlines, 369
Gantt with Timeline view, 127
global template, 415, 418, 419, 424–425
Go To command, 434–435
Go To dialog box, 182, 435
graphic images
  pasting into Project, 445
  snapshots, 424–428, 444
graphical indicators, 339–340
Graphical Indicators dialog box, 339
gridlines, formatting, 133
Group By dialog box, 284
grouping, 15
  group intervals, 283
  More Groups dialog box, 282
  project details, 280–284
  removing, 284
  resource groups, 281
Guide to the Project Management Body of Knowledge, A
  (Project Management Institute), 505, 515, 533

H
Help, 15, 210, 433
highlighting, 285
  change highlighting, 8, 184, 308
  critical path, 210
  task relationships, 170–173
hyperlinks, task, 79–81
images, copying, 141
import/export maps, 450, 452–453, 456
Import Wizard, 451–454
importing data, 451–454
Inactivate command (Task tab), 272
incomplete work, rescheduling, 317–319
Indent Task command (Task tab), 66
  indicators
    Actions indicators, 113
    AutoFilter indicators, 287
    constraint indicators, 183
    contour indicators, 231–232
    deadline indicators, 200–202
    Inserted Project icon, 494
    missed deadline indicator, 346
    overallocation indicator, 240
    recurring task indicator, 206
    red exclamation point, 202
task calendars, 190
  viewing, 118–122
Indicators column, 81
inflexible constraints, 179–180, 182
Information command, 178
Insert Chart dialog box, 408–409
Insert Hyperlink dialog box, 81
Insert Project dialog box, 494
inserted plans, 493–494
instruction with this book, 529–532
interim plans, 304, 367–369

K
keyboard shortcuts, 27

L
lag time, 174–175, 177
Late/Overbudget Tasks Assigned To filter, 333
Late Tasks filter, 325
Layout command (Format tab), 378
Layout dialog box, 187
Layout tab, 22, 36
lead time, 174–175, 178
learning communities, 513–515
legends, 383–384, 410
Level All button, 265
Level Resources dialog box, 259
Leveling Gantt view, 266
line managers, 474
Link The Selected Tasks command (Task tab), 69, 76–77
linking, 67–73
  cross-plan links, 497–500
to Gantt bars or dates, 133–134
managing, 502
respecting, 73
Lync 2010, 86

M
macros
  adding to ribbon tabs, 437–438
  editing, 429–433
  recording, 423–428
Macros dialog box, 427
manually scheduled tasks, 7, 43, 54, 63, 71–72, 192, 242
duration, 57–60
indicator of, 55
manually scheduled tasks (continued)
start and finish dates, 60–61
summary tasks, 211–214
maps, import/export, 450, 452–453, 456
Mark On Track command (Task tab), 157
Mark Task As Milestone command, 64
master (consolidated) projects, 493
material costs, 236–237
material resources, 84
assigning, 236–237
consumption rates, 237
grades of, 510
per-unit costs, 226
setting up, 225–226
unit of measurement, 226
Max. Units field, 86–89, 93, 104
maximum units value, 218, 225, 238, 251
adjusting, 219
Microsoft Enterprise Project Management (EPM), 526–528
Microsoft Excel. See Excel
Microsoft Office Fluent interface, 6
Microsoft Office Online website Project area, 513–514
Microsoft Office Support website Project Support area, 513–514
Microsoft Project 2013. See Project 2013
Microsoft Project MVPs, 513
Microsoft Project User Group (MPUG), 513
Microsoft SharePoint. See SharePoint
Microsoft Visio visual reports, 8, 378, 460–464
Microsoft Visual Basic for Applications (VBA). See VBA
(milestone), 63–64, 136, 201–202
Mini Toolbars, 7–8, 16
missed deadlines, 346–352
More Filters dialog box, 288, 327–329
More Groups dialog box, 282
More Tables dialog box, 290–292
More Views dialog box, 209, 294
mouse input, 6
Must Finish On constraint, 200
Notepad, exporting data to, 455–459
notes, 79–81, 99–102

Office apps, 6. See also Excel
Visio, 8, 378, 460–464
Word, 446–447
Office blog, 521, 526
ongoing operations, 9, 505
Online Analytical Processing (OLAP) cube, 460
Open Resource Pool Information dialog box, 495
Open screen, 18, 485
Organizer, 18, 418–419
Calendars tab, 420–421
elements, copying to global template, 422
elements, copying with, 421
tabs in, 421
Other Views command, 32
Outdent Task command (Task tab), 66
Outline view, 212
output files, 385–387
overallocation, 218, 250
addressing, 245–246
day by day vs. hour by hour, 266
manually resolving, 255–259
from multiple assignments, 468
navigating, 254
resource leveling, 259–266
resources, replacing, 356–357
viewing, 240, 242, 253–254
overtime, 91, 222–223, 352

Page Setup dialog box, 383–384
pan and zoom controls, 137
password protection, 93
Paste Special feature, 444
pasting. See also copying and pasting
into destination programs, 444, 446
into Project, 444–445
pay rates, 90–93
applying at different times, 223–225
applying different rates, 234–235
increases, entering, 223–225
multiple, 221–223
PDF documents, 7, 19, 382, 385–387
peak, 192–193
peak units, 192–193
peak units field, 191
people resources, 86–87. See also work resources
percentage of work complete, 310
performance tracking, 152–165
phases, 64
PivotTables, 460, 462
planning, 65, 299
plans. See also projects
% Complete field, 396–397
% Work Complete field, 396–397
baseline plans, 152, 154–156, 300–304
consolidated and inserted plans, 493–496, 500–501
costs, checking, 267–270
custom elements, sharing between, 418–423
default views, 127
dependencies between, creating, 496–500
duration, viewing, 77–78
emailing, 19
exporting, 19
file properties, setting, 48–49
finish date, checking, 267–270
indicators, viewing, 118–122
information about, 18, 48–49
interim plans, 304
legends, 383–384
new, 18
nonworking days, setting, 45–47
password protection, 93
printing, 18
resource allocation across, 474. See also resource pools
resource pools, 468, 471–473.
saving, 44–45
scheduling, 42. See also scheduling
sharer plans, 468–469. See also sharer plans
sharing, 21, 517–521
snapshots of, 424–428
start date, setting, 43–45
starting, 42–43
tasks, linking across, 497–500
templates, 20–21
timescales, 28
tracking. See tracking progress
PM Network, 515
PMBOK, 505, 515, 533
practice files, downloading, 13
predecessor tasks
details, viewing, 176–177
driving predecessors, 170–172
external, 498–499
viewing, 170–173
Predecessors command (Format tab), 171
Presentation Styles, 129–130
Print Entire Project command, 147
print preview, 146–150, 383–385
Print Specific Dates command, 147
printing
legends, 383–384
page setup, 148–149, 383–385
reports, 145–150
scaling documents, 383
views, 145–150
product scope, 57, 508–509
productivity, resource assignment and, 116
program offices, 478
progress, 158–161. See also tracking progress
progress bars, 158, 160, 318
progress reports, 324
Progress ScreenTips, 160–161
Project 2007, 8
Project 2010, 6–8
Project 2013, 3–4
apps support, 6
certifications, 514
copying data to other programs, 444–449
customization features, 417–440
dynamic recalculation, 152
dynamic updating, 162
description, identifying, 358
descriptions, 4–8
file format, 459
global template, 418
opening other files formats in, 449–454
project management, teaching with, 533–534
project management with, 512
Project Professional edition, 4. See also Project Professional
Project Standard edition, 4
saving other files formats, 454–459
security settings, 450–451
start screen, 14
starting, 14
touch input, 6
visual interface, 6, 14–17
project calendars, 8, 45–47. See also calendars
Project Community, 514
project data
copying and pasting, 7, 329, 444–449
exporting, 329
Index
project data (continued)
  filtering, 7, 284–290
  grouping, 280–284
  sharing, 329
  sorting, 276–280
Project Information dialog box, 43–44
  project calendar, selecting, 45–46
  start and finish dates, 78, 270
  statistics, 105, 326
  system clock setting, 221
Project learning communities, 513–514
project management, 9–10, 505–512
  actuals, collecting, 316
  cost management, 93
  deliverables, defining, 57
  effort-driven scheduling, 116
  large-scale, 526–528
  learning communities, 514–515
  planning, top-down and bottom-up, 65
  with Project, 49, 512
  project status, evaluating, 165
  project status, reporting, 329
  resource allocation, 250
  resource capacity, understanding, 238
  scope, 57
  task durations, 62–63
  teaching with Project, 533–534
  variance, 325
Project Management Institute (PMI), 514
Project Management Journal, 515
Project Online, 5
Project Options dialog box, 19
  automatically adding new resources and tasks, 92
  calculation options, 316, 319
  commands, adding quick access to, 434–435
  critical tasks, marking, 210
  cross-project linking options, 501
Customize Ribbon tab, 436–437
  default views, setting, 127
  new views, tables, filters, and groups options, 282
  Schedule tab, 184
  scheduling options, 115, 319
  startup options, 14
Project Overview report, 329, 391–392
  formatting, 392–399
Project Pro for Office 365, 5
Project Professional, 4
  collaboration features, 517–528
  online services, interaction with, 317
Resource Leveling dialog box, 265
  tasks, inactivating, 271–272, 359
Team Planner view, 241–246
project scope, 57, 357–360, 508–509
Project Server, 43, 521, 526–528
  product portal, 525
Project Statistics dialog box, 78, 122, 270
  duration, 78
  plan costs, 267
  schedule and cost variance, 326, 345–346
project status
  communicating to stakeholders, 323–324
  displaying, 119–122
  reporting, 329
  tracking, 323. See also tracking progress
  variance, 323
Project Summary Name column, 476
project summary tasks, 65, 119–120
  in consolidated plan, viewing, 496
  cost values, 331
  displaying, 79
  finish date, 346
  name, 268
Project tab, 22
  Properties group, 43, 45, 78, 94, 105
  Schedule group, 155
  Status group, 157
project triangle, 324, 343–344, 506–512
Project Web App (PWA), 521–526
  comments, 525
  Home screen, 522
  practice files and, 13
  Project Center, 522
  Projects tab, 522–523
  status updates, 524–525
  task list, 521
  team member view, 524
projects. See also plans
  blank, 15
  critical path, 208–210
  definition of, 9, 505
  deliverables, 57, 506
  duration, 505
  finish dates, 6
  master (consolidated) projects, 493
  new from existing projects, 21
  planning, 299
  resources, 506
Properties dialog box, 48–49, 80–81
PWA (Project Web App). See Project Web App (PWA)
Q
Quick Access toolbar, 15
  commands, adding, 434–435
  commands, removing, 436
  Undo command, 108

R
Record Macro dialog box, 424
Recurring Task Information dialog box, 205–206
recurring tasks, 204–208
  duration, 207
  hiding, 207
  resources, assigning, 206–208
  scheduling, 207
  viewing, 206
Relationship diagrams, 145
remaining costs, 267
remaining work values, 310–311
Remove Highlighting command (Format tab), 173
Replace Resource dialog box, 356–357
Report Name dialog box, 407
Report tab, 21–23, 390
Report Tools tab, 35
reports, 5, 33–36
  Budget Cost Report, 333
  charts in, 390, 408–413
  copying, 140–145
  Cost Overview report, 336
  custom, 137–139, 406–415
  exporting to Excel or Visio, 460–464
  global templates, 415
  naming, 407
  plan costs in, 267
  printing, 145–150
  progress reports, 324
  Project Overview report, 329
  Report Tools Design tab, 391
  resource capacity, viewing, 241
  Resource CostSummary Report, 336
  Resource Overview report, 33–36, 120–120, 400–401
  resource allocation
    examining, 250–255
    fully allocated state, 250
    overallocated state, 250
    overallocation. See overallocation
    underallocated state, 250
  resource calendars. See also calendars
    base calendar, changing, 98
    ignoring, 188
    working times, 93–98
  resource capacity, 238–241
  Resource Cost Summary Report, 336
  resource costs, 333–336. See also costs
    tracking, 333
    variance, viewing, 334–336
  Resource Form, 475–476
    notes, entering, 99–102
  Resource Graph, 255, 260, 399
    resource capacity, viewing, 241
  resource groups, 276, 278–279, 281–282
  resource IDs, 276, 279
  Resource Information dialog box
    Costs tab, 222–224
    Per Use Cost field, 225
    resource availability, 219–221
  resource leveling, 259–266
  Resource Leveling dialog box, 261, 263–265
    Level All button, 265
    overallocations, looking for, 263
    in Project Professional, 265
  resource management, 84–85
  resource notes, 79
  Resource Overview report, 33–36, 120–120, 400–401
  resource pools
    assignment details, viewing, 474–476
    assignment information, clearing, 486
    capabilities of, 469
    creating, 468–474
    dedicated plan for, 474
    naming, 470
    new plans, linking, 485–488
    opening, 485–486, 490
    precedence, 472
    read-only rights, 489, 492
    read-write rights, 489, 491
    refreshing, 492
    Resource Form, 475–476
    saving, 488
    sharer plans, updating, 484
    sharing over network, 489
  Reports feature, 126
  Reset button, 439
resource pools (continued)
storage location, 470
Update Resource Pool command, 489, 491
updating, 478–481, 491–493
working times, updating all, 482–484
Resource Sheet view, 30, 87, 219, 262, 487
cost data, 353–355
Cost table, 334
Cost/Use field, 91, 225
Group column, 281
Max. Units field, 221
Ovt. Rate field, 92
sorting, 277–280
Std. Rate field, 91
Summary table, 277
Resource Stats chart, 33, 121, 401–402
Resource Status table, 34–35, 121
Resource tab, 21, 105
Resource Usage view, 30–31, 475
assignment details timescale, 251
assignment values, displaying, 254
Cost Rate Table field, 235
Notes button, 233
outline view, 251–252
overallocations, editing, 256–259
Project or Task Summary Name column, 476
resource availability, viewing, 239–240
tables, displaying, 254
Usage table, 251
resource variance, 355–357
Resource Views group, 30–31
resources, 3
adding, 88
assigning, 31, 103
assignments, viewing across plans, 475–476
availability, 218–221
cost resources, 8, 84, 98–99
costs, 203, 225, 356–357
custom fields for, 293
details, importing, 6
leveling, 187, 259–266
managing, 6
material resources, 84, 225–226, 236–237
maximum capacity, 88–90
naming conventions, 473
notes, 99–102
overallocation, 88, 90. See also overallocation
overtime, adding, 352
part-time, 94
pay rates, 90–93, 221–225, 234–235
reassigning, 245–246
for recurring tasks, 206–207
replacing, 356–357
in resource pools, updating, 478–481
selecting, 109
start and finish dates, viewing, 121
start time, delaying, 226–229
task status, relationship with, 315–316
unassigning, 107, 114
work resources, 84–93
working and nonworking times, 93–98
Respect Links command (Task tab), 73
ribbon, 6, 15, 21–27, 417
collapsing and expanding, 21
customizing, 7, 434–440
Quick Access Toolbar commands, 434–436
tabs, adding and removing, 436–440
touch input mode, 22
risk, task durations and, 63
Save As Template dialog box, 21
Save Project As File command (File tab), 455
saving
auto saving, 45
file format, specifying, 459
Schedule table, 210
schedule variance, 324–330
identifying, 326–328
missed deadlines, troubleshooting, 346–352
troubleshooting, 345–352
viewing, 345–346
Scheduled Duration field, 214
Scheduled Finish field, 214
Scheduled Start field, 214
scheduling, 73–77
automatically scheduled tasks, 73–74
change highlighting, 69
constraints and, 180–185
dependencies and, 75
details, viewing, 176
drag-and-drop method, 241–246
effort-driven, 112–116
from finish date, 185
formula for, 104, 111, 191
lead and lag times, 68, 174–175
linked tasks, 67–68
scheduling (continued)
  manually scheduled tasks. See manually scheduled tasks
  Must Finish On constraints, 200
  rescheduling, 187
  schedule variance, 324–330
  As Soon As Possible constraints, 200–201
  summary tasks, 211–214
  task types and, 191–196
scheduling modes, 55, 58
  automatic, 73–77
  changing, 74–76
  indicator of, 56
Scheduling Styles, 129
scope
  product vs. project, 508–509
  project scope, 57, 357–360, 508–509
  of work, managing, 357–360
scope creep, 511
ScreenTips
  assignment dates, 252
  dates, 313
  external tasks, 499
  Gantt bar details, 327, 370
  for splitting tasks, 185–186
  task calendars, 190
  task details, 243
  viewing, 183
Scroll To Task command (Task tab), 128, 178
Select All button, 277
selection
  with Ctrl key, 109
  in lists, 109
  Select All command, 448
  with Shift key, 446
semi-flexible constraints, 179–180
Set Baseline dialog box, 155, 303–304
Share Resources dialog box, 471–472
  Break Link option, 488
  Sharing Links path, 486
SharePoint
  calendar view, 519
  integration with, 8
  plans, sharing with, 517–521
  progress, tracking, 518
  Project Summary page, 518
  synchronizing with, 19
  tasks, 518–519
  timeline, 518
sharer plans, 468–469
  adding, 485–488
  assignments, changing, 489–493
  assignments, updating, 476–478
  base calendar, 482
  information, consolidating, 473
  link to resource pool, breaking, 473, 487–488
  opening, 484, 490
sharing
  custom elements, 418–423
  with SharePoint, 8, 19, 517–521
shortcut menus, 16
SkyDrive, 5
slack, 170, 172
  formatting, 210
  free and total, 208
  negative, 184–185
  viewing, 209–210
Slippage command, 370
Slipped/Late Progress filter, 325
Slipping Tasks filter, 325
Slipping Tasks report, 330
Sort By dialog box, 280
Sort command (View tab), 23–24
Sort dialog box, 278–279
sorting, 276–280
source programs, 443
split buttons, 24
Split Task command (Task tab), 185–186
split tasks, 185–187, 233
Split View group, 28, 31
split views, 100
stakeholders, 323–324
Standard base calendar, 93–94, 189
start dates, 42
  actuals, recording, 163–164
  delaying, 226–229
  interim plan, 304
  recording, 161
  of recurring tasks, 205, 207
  Scheduled Start dates, 214
  setting, 43–45, 61, 227–229
  Start No Earlier Than constraint, 184, 205
  viewing, 119
Start No Earlier Than constraint, 184, 205
start screen, 14
start-to-finish (SF) task relationships, 67, 174
start-to-start (SS) task relationships, 67, 174
Statistics dialog box, 346
status bar, 15–16
Filter Applied label, 289
status dates, 319, 330
status reports, 324
stoplight reports, 337–340
subtasks, 120, 252, 444
successor tasks, 170–173
Successors command (Format tab), 172
summary data, 281
Summary table, 277
summary tasks, 64–67
adding to Timeline view, 135–136
duration, 211–214
expand/collapse triangles, 212
formatting, 379–380
inactivating, 271–272
linking to other tasks, 72
manually scheduling, 211–214

Table Definition dialog box, 291
Table Tools tab, 35, 36
tables. See also individual table names
% Complete field, 396–397
% Work Complete field, 396–397
active, 277
charts, adding to, 402–403
columns, adding and removing, 292
copying and pasting data to and from, 444–449
cost rate tables, 222–223
Cost table, 120. See also Cost table
creating, 290–292
custom fields, 293, 337–340
Deadline field, 202
Design tab, 391
displaying, 254
field labels, 390
Field List pane, 390–391
field values, 390
fields, adding, 393–397, 413
fields, removing, 413
fields, reordering, 414
formatting, 390–399
graphical indicators, 339–340
laying out, 36
Layout tab, 391
pasting into Excel, 447–449
pasting into Word, 446–447
pasting text into, 444
reports, adding to, 413–415
resizing, 393–395, 398–399
Resource Status table, 121
Scheduled Duration field, 214
Scheduled Finish field, 214
Scheduled Start field, 214
single-column, 396–397
styles, applying, 395–396, 415
switching among, 156
Variance table, 325, 328, 330
view, adjusting, 307–308
Work table, 330
tabs, 15, 21–27
adding to ribbon, 436–439
in Backstage view, 18–19
collapsing and expanding, 21
Design tab, 22, 35, 399
Format tab, 22, 400. See also Format tab
groups, 15
Layout tab, 22, 36
macros, adding to, 437–438
Project tab, 22, 522–523. See also Project tab
removing from ribbon, 439–440
Report tab, 21–23. See also Report tab
task calendars, 187–190, 422–423. See also calendars
task constraints, 179–185
categories of, 179
default start and end times, 184
finish dates, scheduling from, 185
indicators, 183
negative slack, 184–185
removing, 184
task scheduling and, 180–182
types of, 180
Task Cost Overview report, 332
Task Dependency dialog box, 175
Task Details Form, 352
Task Form, 31–32, 107
cost values, entering, 98
Effort driven option, 115
lead and lag times, entering, 175
task type information, 192
Work details, 108
Task Information dialog box
Calendar box, 190
constraints, adjusting, 183
Task Information dialog box (continued)
cross-plan link options, 502
deadlines, entering, 201–202
displaying, 178
Effort Driven option, 115
lead and lag times, entering, 175–177
linking tasks, 70
Notes tab, 79–81
Predecessors tab, 70
task type information, 192, 195–196
Task Inspector pane, 8, 176, 183
task list synchronization, 517–520
Task Mode column, 56
task notes, 79–81
Task Path, 5, 170–173, 208
Driving Predecessors command, 171–172, 347–348
Predecessors command, 171
Remove Highlighting command, 173
Successors command, 172
task relationships, 68–69, 378
adjusting, 178–179
appearance of, 497
lead and lag times, 174–175
type, changing, 351–352
viewing, 170–173
Task Sheet view, 30, 268
Cost table, 330–331
custom fields and formulas, 337–338
Variance table, 156, 328
Task Summary Name column, 476
Task tab, 21–22
Clipboard group, 141
Editing group, 81, 128
Insert group, 57, 63, 66
Properties group, 80
Schedule group, 66, 69, 159
Tasks group, 74
task types, 191–196
changing, 192, 195–196
effort-driven scheduling and, 191, 196
fixed duration, 191
fixed units, 191
fixed work, 191
Cost Rate Table field, 235
Notes button, 233
tasks, splitting, 233
Task Views group, 31
tasks, 3, 54
actuals, 161–165, 308–309
assignments, adding and removing, 112–116
baseline, updating, 301, 303
completion percentages, 158–161
copying to other programs, 444
cost resources, 8, 116–117
costs, 90, 202–204, 332
critical, 208–210, 268
custom fields for, 293
default settings, 114–115
delaying, 261
deleting, 57, 359–360
dependencies, 54–60
details, 32
displaying as callouts, 136
duration, 54, 58–63, 77–79
effort-driven, 112–116
finish date, 77–79. See also finish dates
hyperlinks, 79–81
ID numbers, 55, 276, 279
inactivating, 8, 271–272, 359
incomplete, 288–289, 358
inserting, 57
interrupting, 185–187
late tasks, viewing, 330
linking, 67–73, 173–179, 497–500
location in plan hierarchy, 375
manually scheduled, 192, 211–214, 242
material resources, assigning, 236–237
milestones, 63–64
names, 55–57, 130–131
outline structure, 64
predecessors, 67, 70, 170–173, 176–177, 498–499
priority, 263–264
progress bars, 318
progressing as scheduled, 157
project summary, 65
promoting and demoting, 66
reassigning, 245–246
recurring, 204–208
rejoining splits, 187
rescheduling, 317–319
resource status, relationship with, 315–316
resources, assigning and unasigning, 31, 103–116
scheduled and unscheduled, 241
scheduling. See scheduling
scrolling to, 128–129
selecting, 182
tasks (continued)
  slipped, 324–330
  splitting, 185–187, 233, 261
  status dates, 330
  subtasks, 64
  successors, 170–173
  summary, 64–67
  Timeline view, adding to, 134–136
  timephased actuals for, 313–315
  unassigned, 252
  Work Breakdown Structure codes, 375–377
  working time, adjusting, 187–190

team collaboration with PWA, 521–526
Team Planner view, 7, 241–246, 255
templates, 20–21, 43

text
  copying to other programs, 444
  formatting, 370–373
  pasting into Project, 444–445
Text Styles dialog box, 372
time constraints, 507
Timeline view, 7, 28, 36, 119–120
copying, 142–144
customizing, 134–137
detailed format, 143
exporting as PDF or XPS file, 385–387
formatting, 371–373
Gantt Chart view, panning and zooming, 137
star and finish dates, 77–78
timephased actuals
timesheet data as, 312
tracking, 299, 312–316
timephased grid
  actuals, entering, 312
cells, working with, 234
details, displaying, 307
duration, viewing, 228
settings, adjusting, 252–253
in Task usage view, 233
  Work and Actual Work rows, 306–307
work values, 252
zoom level, 240
timephased values, 154
timescale, 389
  adjusting, 28, 31, 245, 255, 313
Timescale box, 28
Timescale command (View tab), 31
total slack, 208
touch input, 6
  enabling, 22

Tracking Gantt view
  baseline dates vs. actual or scheduled dates, 325–327
  formatting, 365–370
  task baseline values, 301–302
  tasks as currently scheduled, 301
tracking progress, 152
  actuals, 161–165, 305–310
  level of, 153, 300
  plan as scheduled, 157–158
  Project updating process, 162
  resource costs, 333
  simple method, 161
  task completion percentage, 158–161
  timephased actuals, 299, 312–316
Tracking tables, 162
training with this book, 529–532
teach expenses, 98–99
Trust Center dialog box, 450–451

U
Undo command, 108
  multi-level, 8
Update Project dialog box, 157–158, 318
Update Resource Pool command, 489, 491
Update Task dialog box, 159, 163–164, 432
usage views, 31, 268, 307, 333, 336

V
variance, 299, 323
  addressing, 343
  cost variance, 330–333, 336–341
  schedule variance, 324–330
  start and finish date variance, 325
  work variance, 333
Variance table, 156, 325, 328, 330
VBA Editor, 423, 429–432
VBA (Visual Basic for Applications), 429, 433
  macros, recording, 423–426
View Definition dialog box, 295–296
View label, 16
View tab, 22–23
  Data group, 162
  Resource Views group, 30–31, 87
  Split View group, 28–29, 31, 107–108
  Task Views group, 31
  Zoom group, 28, 173
views, 27–32. See also individual view names
  active, 16
  All Subtasks view, 214
  AutoFilter arrows, 278, 285
  Backstage view, 7, 17–21
  built-in, 294
  Calendar view, 25
columns, inserting, 194
copying, 140–145
creating, 294–297
customizing, 127–137
default views, 27, 127
detail Gantt view, 209
display settings, 296–297
Entire Project view, 212
exporting, 385–387
filtering data in, 285–290
formatting, 364–381
Gantt with Timeline view, 127
graphic-image snapshots of, 444
grouping data in, 280–284
Leveling Gantt view, 266
Network Diagram view, 280
Outline view, 212
printing, 145–150, 381–385
Resource Graph view, 399
Resource Sheet view, 30, 87, 219, 262, 487
Resource Usage view, 475
shortcuts, 15–16
sorting data in, 276–280
task-centric or resource-centric, 295
Task Form view, 107–108
Task Sheet view, 30, 268
Task Usage view, 31, 193–195, 227–228
Team Planner view, 7
timeline view, 7, 28–29, 36, 119–120
timescaled, 389
View labels, 16
viewing, 32
vs. reports, 389–390
Visio visual reports, 8, 378, 460–464
visual reports, 8, 460–464
Visual Reports dialog box, 461

W
what-if scenarios, 271–272
Windows, arranging, 471
Windows Snipping Tool, 140
Word, pasting Project data into, 446–447
work. See also actual work
  adjusting, 194–195
calculation of, 111–112
effort-driven tasks, 112–116
incomplete work, 317–319
interrupting, 185–187
manually editing, 232–233
percentage of work complete, 310
reducing, 258–259
remaining work, 310–311
rescheduling, 317–319
sequence, 174–175
start of, delaying, 226–229
viewing, 118–122
work assignments, 31. See also assignments
Work Breakdown Structure (WBS) codes, 375–377
work contours, 229–233
Work details, 108
Work Overview reports, 138–139
copying, 143–144
printing, 148–150
work resources, 84. See also resources
  allocation of, 250–255
  assigning, 103–116
  availability, 85–86
costs, 116, 510
  maximum units value (capacity), 88–90, 218–221
  multiple assignments in multiple projects, 468
  names, 85–88
  pay rates, 90–93
Work Status chart, 403–405
work table, 162–163, 306, 330
work variance, 333
working capacity, 88–90
working time, 93–98
  adjusting, 187–190
  maximum units, 88–90
  in resource pools, updating, 479–484
working-time exceptions, 8, 45–47, 94–95

X
XML format, saving projects as, 454
XPS documents, 7, 19, 382, 385–387

Z
Zoom group, 28
zoom levels, 173, 240
Zoom Slider, 15–16, 28